InterscopePlus User Manual

Table of Contents

I. InterscopePlus Overview ........................................................................................................5
II. Definitions and Terminology ................................................................................................5
III. Users, Roles and Permissions ..............................................................................................8
   A. New Account Instructions for Designers ........................................................................9
   B. New Account Instructions for Contractors .....................................................................10
   C. New Account Instructions for Owner Agencies ...............................................................12
IV. Navigation ............................................................................................................................14
   A. Home ................................................................................................................................14
   B. Searches ............................................................................................................................14
   C. Hyperlinks .......................................................................................................................14
V. Entering Information .............................................................................................................15
   A. Hierarchy of Data ...............................................................................................................15
   B. Authorization ...................................................................................................................15
   C. Creating a Program ..........................................................................................................17
   D. Allocating Funds ...............................................................................................................18
   E. Creating a Project .............................................................................................................22
   F. Entering Cost Estimate .....................................................................................................27
   G. Determining Project Type ...............................................................................................33
   H. Assigning Funds ...............................................................................................................38
   I. Financial Worksheet .........................................................................................................41
   J. Creating a Design Contract ...............................................................................................44
   K. Entering Design Amendment ...........................................................................................51
   L. Creating a Construction Contract ....................................................................................54
M. Construction Contract Change Orders ..............................................................................58
   1. For Formal Projects .........................................................................................................58
   2. Informal Project Change Orders .....................................................................................65
N. Contingency Funds ...............................................................................................................66
O. Entering Other Commitments ..............................................................................................67
P. Entering Expenditures ..........................................................................................................70
1. Designer Expenditures ................................................................. 70
2. Construction Expenditures ........................................................ 71
3. Other Expenditures ................................................................. 72
Q. Entering HUB Data ................................................................. 73
   1. Good Faith Efforts .................................................................. 74
   2. HUB Entry as part of a Standard Project – Single Prime ........ 76
   3. HUB Entry as part of a Standard Project – CM at Risk .......... 79
   4. HUB Only data entry/Non-code-item-center entry ................ 81
R. Electrical Certificate or Inspection ........................................... 85
   1. Step 1 - Select the Package .................................................. 85
   2. Step 2 - Selection the Electrical Contractor ......................... 87
   3. Step 3 – Verify the contractor’s license status ....................... 89
   4. Step 4 – Complete the data entry ........................................ 91
   5. Step 5 – Save the record ...................................................... 94
   6. Step 6 – Submit the Certificate or Inspection ....................... 95
   7. Step 7 – Print the document ................................................ 95
   8. Maintaining Electrical Contractor Profiles .......................... 98
S. Electronic Change Order Processing ....................................... 102
   1. Formal Projects .................................................................... 102
   2. Submitting the Change Order for Review .............................. 104
T. Closing a Project ....................................................................... 106
   1. Construction Closeout ........................................................ 106
   2. Package Completion ........................................................... 111
   3. Design Contract ................................................................. 111
   4. Contract Closeout .............................................................. 112
   5. Financial Closeout ............................................................. 113
U. Closing a Program .................................................................... 116
VI. Advanced Functions ............................................................... 117
   A. Funds Change Request .......................................................... 117
   1. Funds Transfer .................................................................... 117
   2. Increase/Decrease ............................................................... 120
   B. Primavera (P6) Linking to Interscope ................................... 121
   1. Establishing the Link .......................................................... 122
2. Select the Auto-Map Milestones to have the program match as many milestones as possible without user intervention .................................................................................................................. 122

VII. Reporting ................................................................................................................................................................................. 124

VIII. Problem Reporting/ User Feedback/Help ................................................................................................................................. 126

A. Problem Reporting ........................................................................................................................................................................ 126

B. Contact ....................................................................................................................................................................................... 127

IX. Evaluations .................................................................................................................................................................................. 128

A. Evaluation Status ........................................................................................................................................................................ 128

B. Evaluation Rating ....................................................................................................................................................................... 128

C. Accessing Evaluations ................................................................................................................................................................. 129


2. Project Detail – “Evaluations” tab ............................................................................................................................................ 130

3. Design Contract Detail – “Evaluations” tab .......................................................................................................................... 130

4. Package Detail – “Evaluations” tab ......................................................................................................................................... 130

5. Construction Contract Detail – “Evaluations” tab .................................................................................................................. 130

6. Project Design and Construction Closeout ........................................................................................................................ 131

7. Evaluation Search Page ............................................................................................................................................................ 131

D. Maintaining Evaluations ........................................................................................................................................................... 132

E. Generating the Evaluation Form .............................................................................................................................................. 133

F. Completing the Evaluation Form .............................................................................................................................................. 133

1. Designer Evaluations ................................................................................................................................................................. 133

2. Contractor Evaluations ............................................................................................................................................................. 135

3. Uploading the Evaluation Form ............................................................................................................................................. 136

4. Finalizing the Evaluation ......................................................................................................................................................... 138

5. Alert Notifications .................................................................................................................................................................... 138

G. Project Design and Construction Closeout ........................................................................................................................................... 139

H. Certificate of Merit Recommendations ............................................................................................................................................ 140

X. Creating Owner Contracts on Full Oversight projects ........................................................................................................ 141

1. Step 1 – Select the Project and access the “Contracts” tab: .................................................................................................. 141

2. Step 2 – Click on the “Add Owner Contract” button to add an owner contract: ................................................................. 142

3. Step 3 – Select the Designer for the contract: .................................................................................................................... 142

4. Step 4 – Once the designer is selected, the New screen will be displayed. Complete data entry selecting the desired contract type and entering data for the remaining fields ........................................... 143
5. Step 5 – Use Action->Save to create the contract. Notice that only a subset of the tabs are displayed for owner contracts.

6. Step 6 - The contract will now appear under the Project’s “Contracts” tab.

XI. Primavera (P6) Linking to Interscope

A. Overview

B. Getting Started

C. The Integration Process

1. Select the Project>P6 Link tab, select the box that says “Link Project Milestones to P6 Schedule,” and select the project from the dropdown project list.

XII. In-House Designers and Project Coordinators

A. Creating In-House designer profiles

B. Assigning Profiles to Agencies

C. Creating Contracts using in-house designer profiles

D. Special considerations for In-House Project Coordinator profiles

1. A. Verification of compliance with North Carolina General Statute 133.1.1

E. Construction Contract limits

F. Permissions

XIII. Data Importing for Connect NC Bond Cash flows
I. InterscopePlus Overview

Interscope was originally created in 1999 for the State Construction Office for internal use in tracking projects as they moved through the office. In 2012, the decision was made to incorporate the functionality of the University System’s “CAPSTAT” Capital Project Status software into Interscope, and then further to create a state-wide Capital Project System that would be used by the University System, Community College System, and all State Agencies. InterscopePlus is now that system.

InterscopePlus is designed to track the life cycle of Capital Projects from the time they are authorized until they are closed out, including funding sources and HUB data. It is not intended to be an accounting system.

II. Definitions and Terminology

**Allocate**: Designating funds from an authorization to a program. All funds must be allocated to programs before the programs are active so that funds may be used for projects.

**Amendment**: A change to a design contract.

**AP**: Advance Planning

**Assign**: Designating funds from a program for use in a project. Funds must be assigned to a project before they can be committed or obligated for contracts or other expenses.

**Authorization**: Approval by the relevant State governing body(ies) (legislature, OSBM, UNC Board of Governors) or County to execute a project. It includes title, description/scope, amount, funding type (general fund, non-general fund, state debt, non-state debt, R&R, R&R debt), budget code, item, center, and date. Community Colleges may have authorizations approved by the County. Authorizations may be allocated to one or more Programs.

**Category**: Project cost estimates are delineated by 4 categories: Design, Construction, Contingency, and Other.

- **Design** represents the estimated cost of the design contract
- **Construction** represents the estimated cost of all construction contracts
- **Contingency** represents the estimated cost of construction contingency
- **Other** represents the estimated cost of project related or owner costs, such as soils exploration, advertising, fixed furnishings and equipment (FF&E), etc.

**CD**: Construction Documents

**Change Order**: A change to a construction contract, either to the dollar amount, duration or both.
**Code:** A 5 digit number that designates the funding authorization assigned by OSBM. The first digit is a 4, which signifies capital project. The second and third digit represents the fiscal year that the project is authorized (14 = 2014). The last two digits indicate the state agency or UNC institution. For Community Colleges that are authorized funding by the County a 5 digit number that does not start with 4 will be used.

**Commitment:** A signed contract or Purchase Order for which the State or County is obligated to pay the stated amount.

**COPS:** Certificates Of Participation, Special Indebtedness

**DD:** Design Developer

**Estimated Cost:** Total estimated cost of the project, broken down by category. Typically, this would come from the State Construction Office OC-25 form or, for Community Colleges the NCCCS 3-1 Form.

**Expenditure:** A dollar amount that has actually been paid.

**FF&E:** Fixed Furnishings & Equipment

**FD:** Final Documents

**Fund Source:** There are 6 different sources of funds defined:

- **General Fund:** Appropriated funds
- **Non-General Fund:** Receipts, grants, gifts, cash, County appropriated funds, etc.
- **State Debt:** State Bonds, COPS, or Special Indebtedness
- **Non-State Debt:** Bonds issued by Institutions, county, or self-liquidating funds
- **R&R:** Funding for R&R from appropriations
- **R&R Debt:** Funding for R&R from State Debt, such as Special Indebtedness or COPS.

**HUB:** Historically Underutilized Businesses, and commonly used to refer to Minority Participation or Minority Business Enterprises (MBE).

**Item:** A 3-digit number assigned by OSBM in combination with the code to form a unique identifier for an authorized capital project. Item numbers are assigned sequentially within each fiscal year.

**MBE:** Minority Business Enterprises

**Milestone:** Key date that is used to measure progress of a contract or project.

**NCAS Center:** A unique data item of up to 8 alphanumeric characters that identifies the financial account in the North Carolina Accounting System (NCAS) related to a capital code-item.

**Non-Code-Item Project:** A project that does not have, nor require, a capital code-item (<$300,000). These are typically small informal projects that are accomplished with local or operating funds, but recording HUB participation is required.

**Non-General Fund:** Receipts, grants, gifts, cash, County appropriated funds, etc.
**Non-State Debt**: Bonds issued by Institutions, county, or self-liquidating funds

**Package**: A “process container” for a construction project within the InterscopePlus system which provides a place to record detailed information captured during design review, bidding, award, and the construction administration phases of a construction project.

**Primavera (P6)**: Statewide project scheduling system. Schedules are required for projects with estimated costs over $500,000, based on Project Type.

**Program**: A collection of one or more projects closely related by initial authorization, by the related nature of their execution, and/or having multiple funding sources for a single project. The program serves as a “bucket” for funds from different authorizations that can then be assigned to projects as needed. Program IDs are generated and assigned by the system.

**Project**: A project is typically any work requiring a design and construction contract, and may involve construction or renovation of a single building or repairs to numerous buildings as authorized in “R&R” funding. Project IDs are generated and assigned by the system. Projects must be created in the Program from which they will be funded.

**Project Type**: A designation based on agency/institution, dollar amount of project, funding type, and other factors that determines what oversight role SCO will exercise, such as managing design and construction contracts, reviews, etc. and the P6 schedule requirements. There are different project types based on the department/agency, authorization, and dollar amount of the project.

**R & R**: Repairs and Renovations Funding for R&R from appropriations

**R&R Debt**: Funding for R&R from State Debt, such as Special Indebtedness or COPS.

**Special Project Designation**: Classification of certain projects that are not given an OSBM code-item and do not follow the typical financial controls. These include Guaranteed Energy Savings Performance Contracts, Foundation Projects, Non-Code-Item Projects, and HUB only.

**State Debt**: State Bonds, COPS, or Special Indebtedness
III. Users, Roles and Permissions

Every user must have a username and password. If you do not have one, refer to the State Construction Office Website [http://www.interscope.nc.gov/Interscope/Logon.aspx](http://www.interscope.nc.gov/Interscope/Logon.aspx) Download the appropriate form – Agencies; Universities; Designer/Contractors, for requesting a logon.
A. New Account Instructions for Designers

Follow these steps for creating a new Designer user account:

1 – Select **Designer** in the **User Type** field. This will display the entry form.

2 – Complete the form for the fields indicated.

**Note:** It is important that the email address entered for the Firm be one that represents the firm directly and is not necessarily defined for a particular individual since all communication from InterscopePlus for this account will be sent to the email address on file.

2 – Click **Submit**. A request will be sent to the InterscopePlus Administrator who will review your request, verify the information against the data in InterscopePlus, activate your account and send an email notifying you that the account has been activated.

**Note:** A user account cannot be established for any firm that does not have prior or current approved and active construction projects setup in InterscopePlus.
B. New Account Instructions for Contractors

Note: Any Contractor requesting to use InterscopePlus must first be registered with Vendor Link, the Interactive Purchasing System. InterscopePlus uses Vendor Link to obtain verifiable name and address information.

To register with Vendor Link through the eVP Electronic Vendor Portal, access the following URL and complete the Vendor Registration process:

https://vendor.ncgov.com/vendor/login Once you have received notification that your Vendor Link registration has been completed, you may request a logon for InterscopePlus.

Follow these steps for creating a new Contractor user account:

1 – Select Contractor in the User Type field. This will display the entry form.
2 – Click on the Search VendorLink button. This will display the search page.
3 – Enter the first 3 letters of your company name and press Search. This will display search results.
4 – Find your company listing in the search results and press **Select**. This will fill in your company information and return you to the account request form.

5 – Complete the remaining fields on the form and press **Submit**.
Note: It is important that the email address entered for the Firm be one that represents the firm directly and is not necessarily defined for a particular individual since all communication from InterscopePlus for this account will be sent to the email address on file.

6 - A request will be sent to the InterscopePlus Administrator who will review your request, verify the information against the data in InterscopePlus, activate your account and send an email notifying you that the account has been activated.

Note: user account cannot be established for any contractor that does not have prior or current approved and active construction projects setup in InterscopePlus.

C. New Account Instructions for Owner Agencies

Follow these steps for creating a new Agency, Community College or University user account:

1 – At the logon screen, download the appropriate request form and completely fill it out.

2 – Each Agency and/or Department should have one person designated to review and approve the requested roles/permissions.
When the InterscopePlus system administrator creates an SCO or Owner-Agency user, the user is assigned one or more roles such as Project Manager, or Capital Project Coordinator (CPC), or Financial Manager. Each role allows the user to access specific information and perform specific actions within the system. The Menu options shown on the page header may vary based on the Role or Roles assigned to the user. As an example, a Project Manager may be able to view information only for projects within their agency or institution.

Permissions are part of roles, and determine whether the Role can add, change, delete, or only view the data on a given screen. The Project Manager role can allow the user to view the funding sources for a project but not be able to change them, but the user can change Milestone dates.

A user can have more than one Role, depending on their job requirements, and Roles can be added or deleted as job requirements change. The System Administrator must make those changes, based on requests from the appropriate management level.

This manual does not attempt to identify role requirements for each type of interaction.

3 – Once the completed form has been approved, submit to the System Administrator at Interscope@doa.nc.gov.

4 – The administrator will notify the requestor when the user has been set up.
IV. Navigation

A. Home
Each user has a home screen and will have tabs for ‘System Notices’ and ‘My Favorites’ that will allow them to go directly to a program, project, or contract they want to work on. Depending on your position or role, you may have additional clipboards such as ‘My Projects’, ‘Change Orders in Progress’ or ‘Funds Transfers’.

B. Searches
Much of the navigation in InterscopePlus is accomplished using Searches. You can enter as few or as many criteria as you wish. The more criteria that are entered, the more specific the results and so the shorter the list of returned data. It is possible to put in so many criteria that the search will return 0 results. If this happens, try broadening the search criteria by removing some. If changing search criteria, be sure to clear any unneeded items, or . Scroll to the bottom of the results list and on the left side it will show how many pages of results there are. Search results can be exported to Excel using the button in the lower right hand corner of the screen.

C. Hyperlinks
Examples shown in this manual are basic navigation. Throughout the software there are alternate ways of navigating, many of which utilize hyperlinks. These are shown in blue and are intended to be short cuts to speed up navigation.
V. Entering Information

A. Hierarchy of Data
The data in Interscope follows the typical life cycle of a capital project. It starts with the authorization and funding to do the project. The funding is allocated to a program, and the project is created in the program. The project is designed and then constructed, and HUB is reported on the construction contract. Data must be entered in order, i.e. a project must exist before you can enter a design contract for it, etc.

B. Authorization
Authorizations will typically be entered by a senior level person within a State Agency/Department, by the System Office for Community Colleges or by UNC General Administration for Universities. Your user profile, based on your login information, should autofill the Department.

Note: University: The General Administration office will create all authorizations and programs. Campuses can then create projects once the authorization and program have been created.

Community Colleges: The System Office will create all authorizations, programs and projects.

From the Home screen, select Authorizations>Authorization.
This will bring up the Authorization Search screen. Select the “Add a New Authorization” button.

Fill in the appropriate information. Required fields are marked with asterisks and have a red border. Budget Item OR NCAS Center is required, but not both, however all three may be entered. Click on . Note that the Status is “Allocation in Progress”. This will not change until all funds are allocated to programs.

Once saved, the Authorization detail tabs show up on the lower part of the screen. There is also a system assigned Authorization #. Select the ‘Authorization Item Detail’ tab and enter the
amount of the authorization in the proper fund source(s). When all fund sources have been entered, the authorization will become “Active” for use.

C. Creating a Program

At the top of your home page, select Programs>Program to bring up the Program Search Screen.

If you are not sure if a Program already exists, perform a search for it by entering any search criteria that might be applicable. If the Program does not exist, click Add a New Program.
The New Capital Program screen comes up. Enter the appropriate information. Required fields are marked with asterisks and have a red border. The Program Name should be the same as the Authorization Title. The Alternate Name is not required but it is for the local Agency/Institution to use if they refer to the Program by a different name. Then

You should now see the Program Screen with the new Program # and tabs below it. The Program # is generated by the system and cannot be changed.

D. Allocating Funds

Funds are allocated from an Authorization to one or more Programs. If there are multiple fund sources for an authorization, make sure that you select the one you want to allocate. You must perform a separate allocation for each fund source to each Program.

NOTE: All funds must be allocated to change the Authorization status from ‘Allocation in Progress’ to ‘Active’
Start by selecting Authorizations>Authorization.

This will bring you to the Search screen. Enter appropriate data and for the authorization.

The search will return a list, below, of all Authorizations that meet the criteria. Select the appropriate one by clicking on the ‘SELECT’, Auth ID or Code-Item-Center for that Authorization.

That will bring you to the Authorization Information screen. Select the ‘Program Allocation’ tab, then the ‘Add Allocation’.
This will bring up a Program Search. Enter the appropriate information and click .

From the search results, 'Select' the desired Program.
This returns you to the Authorization Program Allocation screen with the selected program displayed, ready for you to enter the appropriate dollar amount to be allocated.

Enter the amount to allocate to the Program and click on . You will then see that the funds are allocated, they are available to assign, and because all funds are now allocated, that the Authorization Status is “Active”.
E. Creating a Project

NOTE: The Project must be created under the Program that will provide the funding for it.

Projects will be created by the Agency, Community College or University “Owner.” At the top of your home page, select Programs>Program to bring up the Program Search Screen.

Enter the appropriate information and Search.
The search results will show all Programs that meet your criteria. ‘Select’ the Program you want.

You will now be in the Program. Select the ‘Projects’ tab, then the ‘Add Project’ button.
Now you are on the New Capital Project screen.

Enter the Project Information – Basic, and Advanced as appropriate. Required fields are marked with asterisks and have a red border. The Agency Project Code is optional.

Determining the Special Project Designation

In the Advanced block, select the appropriate type of project under Special Project Description.

- **Standard Project**: The default type that will apply to most Capital projects.
- **Performance Contract**: This applies to Guaranteed Energy Savings Performance Contracts
- **Foundation Projects**: This applies primarily to UNC System projects that are designed/constructed by a foundation but must be reviewed by SCO
- **Non-Code-Item Projects**: This is for projects that do not go through the normal State authorization process, such as county funded projects at Community Colleges, or projects completed with operating funds. This will also be used for reporting small project HUB information. An Estimated Project Completion date, Funding Source, Estimated Cost and Fiscal Year Funded must be entered. These fields appear for entry only when the Non-Code-Item type is selected.

Disregarding Performance Contracts and Foundation Projects, the proper sequence for determining what the project designation should be is:

- Does it have a capital code-item funding source? If so, it will be a standard project, regardless of cost estimate.
- If it doesn’t have a capital code-item funding source, then it belongs in a Non-Code-Item Program.
• If it will have a design contract or require any review by SCO (including code only), regardless of cost estimate, it will be a Non-Code-Item project.

• If there will be no SCO review and no design contract, and it is being entered only to meet the requirements for reporting HUB data, it is a HUB only project.

Standard Projects have financial controls, which require funds be assigned to the project and commitments cannot exceed funds assigned. Non-Code-Item Projects do not have financial controls and funds cannot be assigned to them.
NOTE: Once you have selected the project designation and saved, it cannot be changed. If it is the wrong designation, it will have to be deleted and re-entered with the proper designation.

Then...

After saving, the system assigns a project number and displays all the respective Project tabs.
F. Entering Cost Estimate

Cost Estimate, in terms of InterscopePlus, refers to the OC-25 for capital projects, or Form 3-1 for Community Colleges. If the OC-25 for the project has been certified by SCO, it will show on the separate tab for the ‘Cost Estimate’. If the project name has been changed, the system may not find the OC-25 and the ‘Search’ feature can be used to find it. If an OC-25 does not exist, there is an option to create one. While an OC-25/Form 3-1 is required for the authorization of particular types of projects, with some exceptions cited elsewhere in this manual, some type of general cost estimate information is necessary to establish a project. General estimate information is entered as part of the process of establishing the project type described in detail in the next section.

From the Programs tab, select Cost Estimate

Enter your Department and Agency and click the Search button
From your search results you can select a Cost Estimate or Add

You can add selected cost estimates as well as export this data.

To add a Cost Estimate, you must complete the fields in red.
Click on this link to open the OC-25

The screen will open to the OC-25 Template

Files

OC-25-Template 9-2016.xlsx

XLS • 17.8 KB

Download

Details

This resource is related to:

Forms  State Construction Office
Sample of the OC-25 Worksheet

<table>
<thead>
<tr>
<th>STATE OF NORTH CAROLINA - DEPARTMENT OF ADMINISTRATION</th>
<th>Form OC-25</th>
</tr>
</thead>
<tbody>
<tr>
<td>STATE CONSTRUCTION OFFICE</td>
<td>(Rev 09/16)</td>
</tr>
<tr>
<td>PROPOSED REPAIR &amp; RENOVATION OR CAPITAL IMPROVEMENT PROJECT</td>
<td></td>
</tr>
<tr>
<td>BIENNIAL 2015 - 2017</td>
<td></td>
</tr>
</tbody>
</table>

DEPARTMENT and DIVISION: 
PROJECT IDENTIFICATION: 
PROJECT CITY or LOCATION: 

PROJECT DESCRIPTION & JUSTIFICATION: (Attach additional data as necessary to indicate need, size, function of improvements as well as a master plan.)

<table>
<thead>
<tr>
<th>CURRENT ESTIMATED CONSTRUCTION COST</th>
<th>QTY</th>
<th>UNIT</th>
<th>COST PER UNIT</th>
<th>TOTAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. Land Requirement</td>
<td></td>
<td></td>
<td></td>
<td>$0</td>
</tr>
<tr>
<td>B. Site Preparation</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1. Demolition</td>
<td></td>
<td></td>
<td></td>
<td>$0</td>
</tr>
<tr>
<td>2. Site Work</td>
<td></td>
<td></td>
<td></td>
<td>$0</td>
</tr>
<tr>
<td>C. Construction</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1. Utility Services</td>
<td></td>
<td></td>
<td></td>
<td>$0</td>
</tr>
<tr>
<td>2. Building Construction (new space)</td>
<td></td>
<td></td>
<td></td>
<td>$0</td>
</tr>
<tr>
<td>3. Building Construction (existing)</td>
<td></td>
<td></td>
<td></td>
<td>$0</td>
</tr>
<tr>
<td>4. Plumbing (new space)</td>
<td></td>
<td></td>
<td></td>
<td>$0</td>
</tr>
<tr>
<td>5. HVAC (new space)</td>
<td></td>
<td></td>
<td></td>
<td>$0</td>
</tr>
<tr>
<td>6. Electrical (Includes TV &amp; Radio Studio)</td>
<td></td>
<td></td>
<td></td>
<td>$0</td>
</tr>
<tr>
<td>7. Fire Suppression and Alarm Systems</td>
<td></td>
<td></td>
<td></td>
<td>$0</td>
</tr>
<tr>
<td>8. Telephone, Data, Video</td>
<td></td>
<td></td>
<td></td>
<td>$0</td>
</tr>
<tr>
<td>9. Associated Construction Costs</td>
<td></td>
<td></td>
<td></td>
<td>$0</td>
</tr>
<tr>
<td>10. Other:</td>
<td></td>
<td></td>
<td></td>
<td>$0</td>
</tr>
<tr>
<td>D. Equipment</td>
<td></td>
<td></td>
<td></td>
<td>$0</td>
</tr>
<tr>
<td>1. Fixed</td>
<td></td>
<td></td>
<td></td>
<td>$0</td>
</tr>
<tr>
<td>2. Movable</td>
<td></td>
<td></td>
<td></td>
<td>$0</td>
</tr>
</tbody>
</table>

**Total Cost of Work**

*Enter this total in InterSCOPE on Line 3: “Enter the Total”*  
$0

---

30 [Rev. 8 June 2017]
Back in Interscope, you will find in the middle of page “Upload Supporting Documents”. Here you will upload your OC-25 Excel Spreadsheet.
Click on Choose File

You now have a workflow button
G. Determining Project Type

NOTE: ONCE YOUR PROJECT TYPE IS SELECTED AND SAVED IT CANNOT BE CHANGED. PROJECT TYPE MUST BE COMPLETED PRIOR TO ASSIGNING FUNDS.

The Project Type is set when a project is added to a Program.

Select the ‘Project Type’ tab.

Here you will enter information about the project which will be used to determine a Project Type, which in turn determines SCO’s oversight role, what type of P6 schedule will be required, if any, and which milestones will be required. Click on the “Institution and Cost” section to start the process.
For State Agencies and Community Colleges, the Estimated Cost must be subdivided into 4 categories: Design Fee, Construction, Contingency, and Other.

For UNC Institutions, the Estimated Costs must be subdivided into the 4 categories for projects estimated at more than $2M and so subject to SCO oversight. For projects estimated at less than $2M, the estimate may be entered in the 4 categories, or as a lump sum cost by selecting the appropriate radio button.

Enter the cost estimate for the entire project, regardless of the amount of funding that is available. For example, you may only have been authorized funding for advanced planning, but you will enter the estimated cost for the entire project here.
Click on each successive section under ‘Attributes Determining Project Type’ and complete the required information:

State Debt would only be applicable if the funding was provided through State Debt (Bonds, Certificates Of Participation (COPS), Special Indebtedness, or R&R-Debt).

State Land – This will be applicable to most projects except for Community Colleges and some Foundation projects.
Special Project Designation – you already selected this when you created the project.
Special Oversight – This applies to a very limited number of projects, mainly DOT projects, that have a requirement for concurrent Federal oversight.

Oversight Request – If the project would not require SCO oversight, but the Agency/Institution would prefer SCO to have oversight, it can be requested here. An example is if the estimated cost for a Community College project normally not subject to SCO oversight is $490,000, they could request SCO treat it as if it were over $500,000.

When all the entries have been made, then the Project Type is determined and displayed along with the P6 Schedule Requirement, the SCO Role, and Milestones Required.
H. Assigning Funds

**Note:** Before assigning funds to a project, the project type must exist and there must be funds allocated to the program and available for assignment.

If there are multiple funding sources in a program, funds can be assigned to the project from any available source. If multiple funding sources are to be used in a project, each respective source to be used must be assigned to the project.

At the top of your home page, click on Programs>Program to bring up the Program Search Screen.
This will bring up a Program Search. Enter the appropriate information and click [Enter].

The search results will show all Programs that meet your criteria. ‘Select’ to choose the Program you want.

This will bring you to the Program screen. Select the ‘Assign Amounts to Projects’ tab and click on ‘Add Assignment’.

A new window will appear with a list of Projects in the Program. Click on the desired project and then [Select].
Enter the amount of funds you want to assign and then .

To Change an Assignment Amount, type in the new desired amount and .

To review the outcome of your action, you may click on the Project ID or Project Name and it will take you to the Project. Select the ‘Funds Assigned’ tab and you can see the funds have been assigned.
I. Financial Worksheet

The financial worksheet provides information on the financial aspects of the project, including such things as funds assigned, contractual commitments to design and construction. To access this information, navigate to the Project, select the ‘Financial Worksheet’ tab and it will display the ‘Estimated vs Committed’ tab.
The *Assigned Funds* are automatically displayed, based on the total amount of funds assigned from the Program, regardless of funding source. Details can be viewed on the ‘Funds Assigned’ tab.

The *Estimated Cost* data is automatically displayed from the data entered in the ‘Project Type’> ‘Estimated Costs’ tab. These costs can be changed by selecting the appropriate cost category and entering a new number in the field. If the project type has not been established, Estimated Cost information may be entered here.

The *Total Committed* is the sum of all commitments (design contracts, construction contracts and any Purchase Orders). The amounts of the design contract and construction contract are automatically shown when the respective contract is executed. Changes to those contracts are shown in the *Revised Contracts* column and the total of the *Revised Contracts* will become the total committed.

Refer to sections on creating design contracts, creating construction contracts, and change orders for details.
The system will allow the Estimated Cost to be greater or less than the Assigned Funds, but it will not allow Total Committed funds to be greater than Assigned Funds for Standard Projects. Simply put, you cannot contract for any work without having sufficient funds available.

Other $ would be other owner related costs that would appropriately be charged to the project such as advertising, soils exploration, fixed furnishings and equipment (FF&E), etc.

Refer to the section on entering Other Commitments for detailed instructions.

Contingency $ are assumed to be the construction contingency. For projects with design contracts under negotiation, the amount listed as the estimated contingency will automatically be shown as construction contingency when the design contract is established. This may be modified in the design contract negotiation process and revised as appropriate.
J. Creating a Design Contract

For projects that have full SCO oversight, SCO will enter the design contract. This section is intended for non-SCO users to enter University “download,” Community College, or any informal project design contracts.

Navigate to the Project for which the contract will be created. Select the ‘Contracts’ tab, then the ‘Add Design Contract.’

This brings up a Select Designer window. Enter the appropriate information to retrieve the desired designer, then Search. Select the designer.
This will bring up the ‘Detail’ tab, autofill’s the designer information, fills in the Financial Worksheet Summary and the Target Contract amounts from the Project, as shown below.

For the *SCO Plan Review*, there are two options – Limited Oversight or Code Only. The Limited Oversight option requires that you show the Oversight requirements in the box. If there will only be review of plans, select Code Only.
Select the appropriate **Contract Type**.

There are several **Contract Types** to choose from and it is important to pick the correct one.

- **Standard Design Contract (Fully Funded)**: Typical design contract where all funds are available at the time of execution and contract is the full State standard design agreement.
- **Standard Design Contract (Advanced Planning Only)**: This would apply where the design contract amount is negotiated but only a portion is funded. Examples include funding through DD development or through full design but without construction administration (CA) funding availability. Contract is the full State standard design agreement.
- **Letter Agreement (General Use)**: A design agreement using the letter agreement format with the work as described in the agreement. Examples include feasibility studies or work under an open-end design arrangement using a letter agreement.
- **Letter Agreement (Programming)**: Contract for programming using the letter agreement format and as described in the agreement.
- **Letter Agreement (Commissioning)**: Contract for commissioning using the letter agreement format and as described in the agreement.
- **Letter Agreement (Sustainable Energy Programming)**: Contract for energy modeling using the letter agreement format and as described in the agreement.
- **Not Applicable**: This would apply to projects where there is no design contract or code review, such as HUB Only.

Change the **Construction Target $**, **Contingency Reserve Target $**, and/or the **Original Design Fee $** as necessary. Note that the target construction amount is assumed to be the construction budget estimate. If the design agreement should reflect a different amount, for example if you want to design to 85 or 90% of the construction budget during periods of rapidly escalating prices, change the target amount.
If the project is funded for Advanced Planning Only and Standard Design Contract (Advanced Planning Only) is selected as the Contract Type, and funds are limited, check the box for *Limit Design Fee Commitment to the following amount* and insert the proper dollar amount.
The financial controls will not allow a commitment greater than the funds *Available to Commit*.

You can enter any time.

Enter the *Selection Date*, *RFP Letter Date* if applicable, *Agreement* date if agreement has been reached and / or . This will automatically update the *Contract Status* to “Created – Not Signed” and show the proposed commitment.

When the *Signed by Designer* and *Signed by Agency* dates are entered and saved, the *Contract Status* will be changed to “Active.” Once the *Contract Status* is “Active”, the screen will show the CURRENT DESIGN CONTRACT information and the updated commitment in the Financial Worksheet Summary.
Corrections or edits may be made, but require that the contract status be changed to “Creating” in order to open fields for editing, then changed back to “Active” and 

If this is an in-house design, a design contract is still required. Select ‘In-House Design by’ for your agency from the Designer selection list.
Create a contract with $0 and fill in the appropriate dates.

K. Entering Design Amendment

For projects that have full SCO oversight, SCO will enter the design amendments. This section is intended for non-SCO users to enter University “download,” Community College, or any informal project design contract amendments.

Navigate to the design contract, select the ‘Amendments’ tab, and click on ‘Add Amendment’.

It shows the Current contract amount, the Financial Worksheet Summary, Amendment Fees and Funds and Amendment Dates. Enter only the changes to the Fees and Target Funds necessary for this amendment. These changes will be added to the existing contract. A description of the amendment is required. Enter the appropriate dates and
and it takes you back to the ‘Contract Amendments’ tab and shows you the results of the amendment.
On the ‘Detail’ tab, it shows the updated Current Design Contract Design Fee and updated Total Committed.

And on the ‘Project Financial Worksheet’ it shows the Revised Contracts amount.
L. Creating a Construction Contract

For projects that have full SCO oversight, SCO will enter the construction contract. This section is intended for non-SCO users to enter University “download,” Community College, or any informal project construction contracts.

Within the InterscopePlus system, design contracts typically yield documents that require reviews at different stages of design. At the end of the design process, there is a construction contract, and therefore the construction contract is linked to a design contract. The item that connects the design contract and the construction contract is called a Package, and it is primarily how SCO tracks the design review process.

To create a construction contract, navigate to the appropriate design contract, select the ‘Packages’ tab and select the correct package. Normally there is only one package.

You will need to update the Bidding/Construction Contracts information on the ‘Detail’ tab by indicating whether it is a formal contract and the construction procurement type of contract (Single Prime, Construction Manager at Risk, etc.) from the drop-down lists. Entering other information or updating status is optional. Then
Select the ‘Construction Contracts’ tab and then ‘New Construction Contract’.

The Select Contractor window will appear. Enter criteria needed to find the correct contractor, and select the contractor from the search results.

The contractor information is automatically entered, based on your selection, in the ‘Construction Contract Detail’ tab. The Contract Status is set to “Creating” and the default Contract Type is “General Contract.” Select an appropriate contract type if other than “General.” Enter appropriate Award Details, Contract Dates, and Contract Amounts. Required fields are marked with asterisks and have a red border. Entering Owner Contact, Safety Officer, Surety, Sheets and Contractor Contact is optional.

If this is a Standard Project, the system will not allow commitments greater than the assigned funds. To avoid losing data, you can as long as the status is “Creating.” When sufficient funds are available to award the contract, change the status to “Valid Contract” and .
Select the ‘Project #’ tab in the hierarchy, then the ‘Financial Worksheet’ tab. The construction contract now shows up as a commitment.
### Worksheet Summary

<table>
<thead>
<tr>
<th></th>
<th>Assigned Funds:</th>
<th>Total Estimated Cost:</th>
<th>Assigned Funds:</th>
<th>Total Committed:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Fee $</td>
<td>$10,000.00</td>
<td>$10,000.00</td>
<td>$10,500.00</td>
<td>$10,000.00</td>
</tr>
<tr>
<td>Construction $</td>
<td>$100,000.00</td>
<td>$99,500.00</td>
<td>$99,500.00</td>
<td>$99,500.00</td>
</tr>
<tr>
<td>Contingency $</td>
<td>$3,000.00</td>
<td>$3,000.00</td>
<td>$3,000.00</td>
<td>$3,000.00</td>
</tr>
<tr>
<td>Other $</td>
<td>$5,000.00</td>
<td>$5,000.00</td>
<td>$5,000.00</td>
<td>$5,000.00</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>$118,000.00</strong></td>
<td><strong>$109,500.00</strong></td>
<td><strong>$109,000.00</strong></td>
<td><strong>$109,000.00</strong></td>
</tr>
</tbody>
</table>

Estimated Surplus (Need): $2,000.00
Available to Commit: $11,000.00
M. Construction Contract Change Orders

Project Types and Approval Levels

<table>
<thead>
<tr>
<th>PROJECT TYPE</th>
<th>PROJECT DESCRIPTION</th>
<th>OBJECT</th>
<th>OBJECT SUBTYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>Agency Project &gt; $500K</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER SCO</td>
</tr>
<tr>
<td>A2</td>
<td>Agency Project &lt; $500K (State Debt)</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER AGENCY</td>
</tr>
<tr>
<td>A3</td>
<td>Agency Project &lt; $500K (No State Debt)</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER NO WORKFLOW</td>
</tr>
<tr>
<td>C1</td>
<td>CC Project &lt; $500K</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER AGENCY (*)</td>
</tr>
<tr>
<td>C2</td>
<td>CC Project &gt; $500K</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER SCO</td>
</tr>
<tr>
<td>C3</td>
<td>CC Project &gt; $500K &lt;= $4M</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER AGENCY</td>
</tr>
<tr>
<td>C4</td>
<td>CC Project &gt; 4M (State Debt)</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER SCO</td>
</tr>
<tr>
<td>C5</td>
<td>CC Project &gt; 4M (No State Debt)</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER AGENCY</td>
</tr>
<tr>
<td>F1</td>
<td>Foundation Project/Other</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER NO WORKFLOW</td>
</tr>
<tr>
<td>F2</td>
<td>Foundation Project/Other</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER NO WORKFLOW</td>
</tr>
<tr>
<td>G</td>
<td>Federal Oversight Project</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER NO WORKFLOW</td>
</tr>
<tr>
<td>H1</td>
<td>Hospital Project &gt; $500K</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER SCO</td>
</tr>
<tr>
<td>H2</td>
<td>Hospital Project &lt; $500K</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER AGENCY (*)</td>
</tr>
<tr>
<td>P1</td>
<td>Performance Contracts</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER NO WORKFLOW</td>
</tr>
<tr>
<td>P2</td>
<td>Performance Contracts</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER NO WORKFLOW</td>
</tr>
<tr>
<td>U1</td>
<td>UNC Project &gt; $2M</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER SCO</td>
</tr>
<tr>
<td>U2</td>
<td>UNC Project &gt; $500K &lt; $2M</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER AGENCY</td>
</tr>
<tr>
<td>U3</td>
<td>UNC Project &gt; $500K &lt; $1M</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER AGENCY</td>
</tr>
<tr>
<td>U4</td>
<td>UNC Project &lt; $500K</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER NO WORKFLOW</td>
</tr>
<tr>
<td>U5</td>
<td>UNC Project &lt; $500K</td>
<td>CHANGE ORDER</td>
<td>CHANGE ORDER NO WORKFLOW</td>
</tr>
</tbody>
</table>

1. For Formal Projects

The construction change order process provides an electronic process for submitting and approving changes to projects with construction costs over $500,000 and is controlled by a workflow that requires the sequential execution of the steps by the respective parties. Change orders for smaller projects are not processed electronically, but use a simple spreadsheet shown at the end of this section, to record change order information.
Only Designers (or InterscopePlus users given the appropriate permission) are allowed to create and submit change orders for review, processing and approval. The electronic change order process is used for all formal projects, both those subject to SCO oversight and University “download” projects. University change orders follow a slightly different approval process, with the final approval being at the University level rather than at SCO.

a] Creating the Change Order

**NOTE:** Each Proposed Change Order (PCO) requires supporting documentation to be uploaded for review and acceptance. A PCO cannot be added without supporting documentation. It is recommended that all supporting documentation be gathered prior to change order entry.

After logging in, the designer selects the Active Construction Contracts tab on his/her Home screen, then selects the contract for which the Change Order (CO) will be entered and clicks on it.

**Tip:** Use the **SCO File##** to identify the correct Construction Contract.

On the Construction Contract Screen, select the Change Orders tab, then go to

Enter the appropriate information. To upload files, select **Upload Files** at the bottom of the screen. In the File Uploader window, select Choose File to browse for the file to upload.
When the file is selected, it will be uploaded to the window. Upload as many files as necessary. Add a description and the file will show as Change Order # with the next sequential number, show the Status and the Work Flow Activity and the icon appears.
The Designer may continue to make changes to the Change Order using the

up until the time that the Change Order is submitted.
The Designer may choose to abandon or delete the Change Order using the.... However, once it is submitted, no changes or deletions are allowed.

b) **Submitting the Change Order for Review**

To complete this workflow step, the Designer must submit the Change Order to initiate its review and approval by other Project participants. Up to this point, no other Project participant has been involved in the Change Order processing.

Submit the Change Order by selecting the... A Confirmation window will appear to confirm this action. Select **Yes** to continue or **No** to return.

The Change Order workflow is updated and processes any Alerts that are defined for this step.

The system is configured to send Alerts to the Owner, Contractor and Project Monitor. An Alert is sent for each logon associated with each project role.

---

<table>
<thead>
<tr>
<th>Status</th>
<th>Package Status</th>
<th>Contract Status</th>
<th>Status Date</th>
<th>Last Update</th>
<th>Date Reviewed</th>
<th>Total Days</th>
<th>Total Amount</th>
</tr>
</thead>
</table>

---

**Workflow Activity**

<table>
<thead>
<tr>
<th>Event</th>
<th>Action</th>
<th>Activity</th>
<th>User</th>
<th>User Comment</th>
<th>Date Completed</th>
<th>Updated On</th>
<th>Actual On</th>
<th>Result</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Created</td>
<td>Designer</td>
<td>scdesigner</td>
<td>4/21/2015 2:50:30 PM</td>
<td>4/21/2015 2:50:30 PM</td>
<td>Submitted</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Submit</td>
<td>Contractor</td>
<td>scdesigner</td>
<td>4/21/2015 2:50:30 PM</td>
<td>4/21/2015 2:50:30 PM</td>
<td>Submitted</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Approve</td>
<td>Designer</td>
<td>scdesigner</td>
<td>4/21/2015 2:50:30 PM</td>
<td>4/21/2015 2:50:30 PM</td>
<td>Submitted</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Approve</td>
<td>Contractor</td>
<td>scdesigner</td>
<td>4/21/2015 2:50:30 PM</td>
<td>4/21/2015 2:50:30 PM</td>
<td>Submitted</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Approve</td>
<td>Owner</td>
<td>scdesigner</td>
<td>4/21/2015 2:50:30 PM</td>
<td>4/21/2015 2:50:30 PM</td>
<td>Submitted</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Approve</td>
<td>SOD</td>
<td>scdesigner</td>
<td>4/21/2015 2:50:30 PM</td>
<td>4/21/2015 2:50:30 PM</td>
<td>Submitted</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

**InterscopePlus User Manual**

[Rev. 8 June 2017]
c) Receiving and responding to the Alert

Each participant will receive an alert via email concerning actions for each Change Order.

To access the Change Order, simply click on the link at the bottom of the Alert Email.

You will be prompted to Logon and are then directed immediately to the Change Order page.

d) Reviewing and Approving Change Orders

Each participant will receive an alert via email concerning actions for each Change Order.

When the Contractor logs on to InterscopePlus, he/she sees a “Change Orders In Progress” clipboard on his/her Home screen. By selecting a Change Order, he/she can view the Work Flow Activity of that Change Order. Change Orders that are awaiting their action are highlighted in yellow. At this workflow step there are only 2 options that can be performed – Approve or Reject. They are available from the .

Approving the Change Order moves the process along to the next step in the Workflow.
Rejecting the Change Order at any step in the Workflow causes the Change Order to be returned to Step 2 where the originator (Designer) can change and resubmit. The workflow is then reset and the audit trail (found at the bottom of the page) maintains a record of the prior workflow events.

This process continues until the final Workflow Step is completed and the Change Order is marked as Approved (See Status field).

Alerts are sent to all Project participants as a notification that the Change Order has been officially approved.

The owner must certify that sufficient funds are available for the change order before approving. Sufficient funding must be reflected in the InterscopePlus system before the change will be approved by SCO.

**Project Financial Worksheet Summary**

- Assigned Funds: $150,000
- Total Committed: $145,000
- Available to Commit: $5,000
- This Change: $1,000
- Available to Commit After this Change: $4,000

The owner certifies that the project's Assigned Funds are adequate to support this change order: Yes

**Change Order Sequencing**

Change orders must be entered, submitted and approved in sequence. There are safeguards in place to check for any outstanding prior change orders before a newer change order can be approved.
Change orders may also be deleted at any time before submission. The system will review the current sequence of change orders and re-sequence them as appropriate to maintain a consistent ordering.

2. Informal Project Change Orders

The change order process for informal projects involves making entries to identify the nature of the change, cost, and impact on contract days into a spreadsheet format on the ‘Change Order’ tab on the construction contract.

![Change Order Summary Table]

Click in the Description block and enter the description of the change. Tab to fill in any additional days and tab to enter amount of change. Change orders are automatically numbered in the order entered. You may enter as many change orders as necessary, then . The changes are reflected in the Change Orders Summary.

On the ‘Construction Contract Detail’ tab, the total of all change order amounts are also shown.
N. Contingency Funds

Within the context of InterscopePlus, contingency funds are the construction contingency funds that are shown as a line item in the design contract. The amount entered in the estimated cost field for contingency is automatically carried into the design contract, but can be modified before contract commitment. Some Agencies/Institutions choose to use the contingency line as a total project contingency, which is acceptable. For projects with SCO Full Oversight, the amount of construction contingency must be clearly communicated to SCO at the time of design negotiations.

The financial controls look at the assigned funds and the total commitments, and will only allow commitments up to the amount of assigned funds. There is no requirement to update estimated costs to be in agreement with commitments, however the user may do so. There is no mechanism for committing or expending funds from the contingency line. The simplest way to move contingency funds is in the ‘Financial Worksheet’> ‘Estimated vs Committed’ tab. Here the amount in the Estimated Cost can be changed by entering the new amount and saving. A transaction of this type is shown in the example below.

If a more detailed audit trail is desired, the entries may be made directly on the Contingency tab.
Enter the amount of change, or the new total, the reason for the change and where the funds are going. Then save.

The “History of Changes” tracks all changes in Contingency regardless of the method of change.

O. Entering Other Commitments
Other Commitments are those owner expenses related to the project that do not involve design or construction contracts, typically things like advertising, surveys, permit fees, etc.

**NOTE:** Commissioning, Special Inspections, and similar services that are selected using the design contract procedures must be recorded as design contracts, not Other Commitments.

Navigate to the Project ‘Financial Worksheet’> ‘Estimated vs Committed’ tab.
The Estimated Cost Other $ shows $15,000 but the amount of funds Available to Commit is only $2000, and the system will not allow committing more funds than are available. This financial constraint does not apply to Special Project Designations (Performance Contract, Foundation Project, Non-Code-Item Project).

Select the ‘Expenditures – Other’ tab

Enter the number of lines you want to add, 1 line for each PO or other commitment and click the ✉️ sign.
If the vendor is a HUB, check the box at the left. Assign a commitment #, which can be a PO number or anything you want, a purpose or description of what is being purchased, the vendor, and the commitment amount, then **Save**. HUB Vendors must be selected from the vendor search because their certification status is validated as part of the data entry process, but other vendors can be entered by typing the name.

Unlike design or construction contracts, there is no formal process for changing these commitments. If there is an increase or decrease to the commitment amount, simply enter the new correct amount in the **Commitment Amt.** and **Save**. Entering expenditures (payments/invoices) is optional. If there are invoices entered, the commitment amount cannot be reduced below the expenditures and the commitment cannot be deleted.

All the information from this tab rolls up automatically to the ‘Estimated vs Committed’ tab, as shown below.
P. Entering Expenditures

Entering expenditures is optional in this system since it is not designed to be an accounting system, but the opportunity for these entries was provided to assist users in tracking payments to designers, contractors, and other vendors.

1. Designer Expenditures


Enter the invoice number, date, and amount. If you are tracking multiple funding sources, insert the proper funding code from which the funds were taken for the invoice. Then.

The amount expended and remaining balance are shown on the Total Design Contracts line. Note that if you now go to the ‘Estimated vs Committed’ tab, the expenditure also
Construction expenditures are recorded similarly to Designer expenditures. Navigate to the ‘Financial Worksheet’ > ‘Expenditures – Construction’ tab, and click on ‘Add New Row.’

Enter the invoice number, date, and amount. If you are tracking multiple funding sources, insert the proper funding code from which the funds were taken for the invoice. Then press ‘Save.’
The amount expended and remaining balance are shown on the *Total Construction Contracts* line. Again, if you now go to the ‘Estimated vs Committed’ tab, the expenditure also appears.

3. **Other Expenditures**

To enter Other expenditures, a commitment needs to exist first. See [Entering Other Commitments](#). Navigate to the ‘Financial Worksheet’ > ‘Expenditures – Other’ tab and click “Add Invoice.”

As with Design and Construction Expenditures, enter the invoice number, date, and amount. If you are tracking multiple funding sources, insert the proper funding code from which the funds were taken for the invoice. Then **Save**.
The amount expended and remaining balance are shown to the Total line and the expenditure appears on the ‘Estimated vs Committed’ tab.

Q. Entering HUB Data

HUB data must be entered as part of a construction contract.

For Standard Projects with designers or SCO code review, HUB data should be entered at the time of contract award, and the data is saved as “At award.” The Good Faith Effort must be entered. For formal contracts awarded by SCO, data “At award” will entered by them. HUB data should be updated as it changes through the life of the contract and verified before the project is closed. Updating/finalizing HUB data will be the responsibility of the owner agency, university, or community college. A beneficial occupancy date must be entered before HUB data can be finalized.
Non-Code-Item Projects that are construction only (no designer or SCO code review) can be entered as “HUB Only,” which will allow direct creation of a construction contract. The project must be created as a Non-Code-Item Project AND the HUB Only check box must be checked in order to utilize the abbreviated data entry method.

**NOTE:** If a project exists in InterscopePlus because of design or code review, the construction contract and HUB data must be entered under that project, regardless of dollar amount of project.

1. **Good Faith Efforts**

   Navigate to the desired ‘Project’ > ‘Contracts’ tab, and select the construction contract.

   Click on the ‘HUB Good Faith Efforts’ tab. The Good Faith Efforts must be documented to determine if the contractor is responsive. Select the ‘HUB Good-Faith Efforts’ tab, enter the appropriate information, and
Once saved, the system will calculate the number of points and determine if the contractor is responsive.
2. **HUB Entry as part of a Standard Project – Single Prime**

Navigate to the desired Project Contracts tab, and select the construction contract.

Click on the ‘HUB Participation’ tab.

This provides information on the HUB status of the Prime Contractor, and the current HUB participation.

If the contractor has submitted an Affidavit C, on the ‘HUB Participation’ tab click on the **Add Subcontractor** tab.

This will bring up the “Add Subcontractor” search box. Enter information about the desired subcontractor and **Search**.
Select the desired contractor from the pick list. “Link TO IPS” or “SELECT” options are displayed. The difference between these two options is a system parameter involving where address information is stored. Any company that can be “SELECT”ed, is in the InterscopePlus database and can be used for Contractors. Companies that can be “LINK TO IPS” are in IPS database but not in InterscopePlus. If the desired company is not listed, click on the additional box to request the addition. This will open a screen for entry of contractor information including name, address, and telephone which will be routed to the system administrator for approval/entry.

Fill out the form below as completely as possible and click “Request Contractor.” An Administrator will review your request, and you will be notified once a decision has been made.

HUB participation information for this company or a “LINK TO IPS” company may not be entered until the contractor is approved and loaded into the system by the System Administrator. An automatic e-mail will be generated back to the requester when this has been done so that HUB entries may be completed.
The selected subcontractor is displayed on the contractor list, as shown below. Now complete entering the *CSI Division*, *Work*, and *Awarded* amount, check if this is a final payment, and .
The HUB participation is automatically calculated and displayed for Certified HUB contractors. Uncertified HUB firms may be listed, but will not be reflected in the displayed calculations. Continue adding subcontractors as necessary.

NOTE: Contractors/subcontractors will need to be linked to IPS through eVP to capture HUB data.

3. HUB Entry as part of a Standard Project – CM at Risk

HUB Entry for CM at Risk differs from Single Prime in that participation must be reported for each 1st tier subcontractor. Therefore, there is a Trade/Sub Package for each 1st tier subcontractor or Package Prime Contractor, and the HUB subcontractors under each Trade/Sub Package are recorded.

If the construction contract was created as a CMAR, the appropriate HUB Participation (CMAR) tab will show up under the contract.

For each Trade/Sub Package, enter the Pkg# and type of work, then ‘Select Package Prime Contractor’. The Pkg # is user-defined and may be whatever is customary for the organization making the entries. Similarly, the type of work under For is a user-defined entry, but should be generally descriptive of the nature of the work.
Search for the desired contractor and select them.

Enter the *Pkg Amount at Award*. If there are HUB subcontractors for the Package Prime, they should be added by clicking 'Add Subcontractor.'
It is recommended that you enter data after each contractor, as the Hub Participation Summary will be updated when you save.

Continue entering Trade/Sub Packages and Subcontractors until all HUB data is complete.

4. HUB Only data entry/Non-code-item-center entry
Small projects that are NOT part of a code-item-center capital project or, by their nature have no design or code review such as painting, road patching, etc., need to be entered for reporting capital activity as well as recording HUB data. All construction projects whose construction cost is in excess of $30,000 must be reported for HUB participation according to statute. There is an abbreviated method for these entries.

NOTE: If a project exists in InterscopePlus because of design or code review, the construction contract and HUB data must be entered under that project, regardless of the dollar amount of the project.
If the Project is funded from a Capital Project Code-Item-Center, including R&R, it must NOT be entered as a Non-Code-Item Project/HUB Only.
At the Program, navigate to the ‘Projects’ tab and click ‘Add Project’.

Enter the *Title* and *Description*, then select the Special Project Designation “Non-Code-Item.” Refer to Determining the Special Project Designation. The HUB Only checkbox will appear and must be clicked to enter the checkmark. Enter an *Estimated Project Completion*, *Funding Source*, and *Fiscal Year Funded*, then you will be asked to confirm that this is the project designation you want, as it cannot be changed at a later time.

Because there is no Capital Code-Item-Center, and no designer/SCO design reviews, the system assigns the Project Type of <$500K automatically.
Go to the ‘Contracts’ tab and select “Add Construction Contract.”

At the Select Contractor search window, enter selection criteria and click Search.

Click on the desired contractor from the list.
The contractor information is displayed in the ‘Construction Contract Detail’ tab, including HUB Type and Contract status. The Contract Status is set to “Creating” and the default Contract Type is “General Contract.” Select an appropriate contract type if other than “General.” Entering Owner Contact, Safety Officer, Surety, Sheets and Contractor Contact is optional. Enter appropriate Award Details, Contract Date, and Contract Amounts. To avoid losing data, you can as long as the status is “Creating.” When all data is complete, change Contract Status to the appropriate “Valid” contract type and

Enter Good Faith Efforts and additional HUB Participation as appropriate.
R. Electrical Certificate or Inspection

1. Step 1 - Select the Package

Step 1 – Select the Package

To initiate the process of creating an electrical certificate, click on the desired option under “New” on the main menu:

This will display the input form:

The first step in creating a record is to locate the Package for which this certificate or inspection applies.

Use the “Find Package” button to display the Package Search page for locating and selecting the package.
Enter any search criteria that is useful in locating the package. The following example uses the Project ID # to locate a list of packages for selection:
Click on the **SCO ID#** field to select the target package. The search screen will close showing the selected package on the input screen.
To change the package, simply click on the ‘‘**Find Package**’’ button and repeat the search and selection steps above.

2. **Step 2 - Selection the Electrical Contractor**

The next step is to select the Electrical Contractor.
Use the ‘‘**Find Contractor**’’ button to display the Electrical Contractor Search page for locating and selecting the contractor.
Enter any search criteria that is useful in locating the contractor in the Interscope database. The following example uses the contractor **Name** to locate a list of contractors for selection:
Click on the CONTRACTOR field to select the contractor for this record. The search screen will close showing the selected contractor information on the input screen.

3. **Step 3 – Verify the contractor’s license status**

To check the current status of the selected contractor’s license, click on the “Popup NCBEEC Search” button to display a browser tab containing the search page at the NC State Board of Examiners of Electrical Contractors (www.ncbeec.org).
Enter any search criteria that is useful in locating the contractor in the NCBEEC database. The following example uses the contractor **Name** to locate a list of contractors:

![Contact Search Results](image)

Click on the “Detail” button to display the contractor’s license status. Verify that the license status is “**ACTIVE**” or “**ACTIVE IN RENEWAL**”.

To return to Interscope, click on the browser tab “**Electrical Detail**”. The “License Lookup” tab may remain active for subsequent searches.
4. **Step 4 – Complete the data entry**

Finish entering the following fields on the form:

- **Date** – this field is prepopulated with the current date

- [ ] **Utility Work Order** – this field is optional

- [ ] **Disposition** – this field is required

- [ ] **Comments** – this field is required if Disposition = “Approved w/Notes”

- [ ] **Alert Email** – this field is pre-populated with the email that is on file for the contractor. If the alert should be sent to a different email, enter this email in the Alert Email field.

- [ ] **Special Note** – enter any note to be communicated to the monitor assigned to the package. Then check “Send Special Note to Project Monitor?” to notify the monitor.
Figure 1 – Completed Certificate ready to be created.
Figure 2 – Completed Inspection ready to be created
5. **Step 5 – Save the record**

Click on the “Save” option under the **Action** menu to create the new record:

An “... added” message will be displayed:
6. **Step 6 – Submit the Certificate or Inspection**

To complete the processing of the certificate or inspection, click on the “Submit” option under the **Workflow** menu.

This action will finalize the data entry and notify the contractor, designer and project monitor via email alerts of the completed document.

A message will be displayed listing the users alerted:

7. **Step 7 – Print the document**

To print a PDF copy of the completed document, click on the “Print” option under the **Action** menu.
A PDF copy will appear in a new browser tab. To return to Interscope, click on the “Electrical Detail” tab.
### ELECTRICAL INSPECTION

**Date:** 03/30/2016  
**SCO ID #:** 11-08024-03B  
**Utility Work Order #:** 001  

**Owner:** MISCELLANEOUS  
**EC Address:** P. O. Box 849  
**EC Phone:** (252) 236-3111  

**Project:** Test for Release 7.4  
**EC Address:** Elm City, NC 27822  
**EC Email:** james@barnespowell.com  

**Electrical Contractor (EC):** Barnes & Powell Electrical Company Inc.  
**EC Representative:** William Lee Powell  

---

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ROUGH-IN</td>
<td>X</td>
</tr>
<tr>
<td>SLAB</td>
<td></td>
</tr>
<tr>
<td>CEILING</td>
<td></td>
</tr>
<tr>
<td>FINAL</td>
<td></td>
</tr>
<tr>
<td>TRENCH</td>
<td></td>
</tr>
<tr>
<td>WALLS</td>
<td>X</td>
</tr>
<tr>
<td>RE-INSPECTION</td>
<td></td>
</tr>
<tr>
<td>OTHER</td>
<td></td>
</tr>
</tbody>
</table>

---

**SEE PAGE 2 FOR DETAILED COMMENTS**  

Latif Kaid  
State Construction Office  

---

**SCO Electrical Inspector**  
State Electrical Inspector
8. Maintaining Electrical Contractor Profiles
S. Electronic Change Order Processing

1. Formal Projects

The construction change order process provides an electronic process for submitting and approving changes to projects with construction costs over $500,000 and is controlled by a work flow that requires the sequential execution of the steps by the respective parties. Change orders for smaller projects are not processed electronically, but use a simple spreadsheet shown at the end of this section, to record change order information.

Only Designers (or InterscopePlus users given the appropriate permission) are allowed to create and submit change orders for review, processing and approval. The electronic change order process is used for all formal projects, both those subject to SCO oversight and University “download” projects. University change orders follow a slightly different approval process, with the final approval being at the University level rather than at SCO.

NOTE: Each Proposed Change Order (PCO) requires supporting documentation to be uploaded for review and acceptance. A PCO cannot be added without supporting documentation. It is recommended that all supporting documentation be gathered prior to change order entry.

a) Creating the Change Order

After logging in, the designer selects the Active Construction Contracts tab on his/her Home screen, then selects the contract for which the Change Order (CO) will be entered and clicks on it.

On the Construction Contract Screen, select the Change Orders tab, then go to Action and select Add Change Order.

Tip: Use the SCO File# to identify the correct Construction Contract.
Fields in Red are required

In the File Uploader window, select Choose File to browse for the file to upload.
When the file is selected, it will be uploaded to the window. Upload as many files as necessary. Add a description and upload files.

After it is saved, it will show as Change Order # with the next sequential number, show the Status and the Work Flow Activity and the icon appears.

The Designer may continue to make changes to the Change Order using up until the time that the Change Order is submitted.

The Designer may choose to abandon or delete the Change Order using the icon. However, once it is submitted, no changes or deletions are allowed.

2. Submitting the Change Order for Review
To complete this workflow step, the Designer must submit the Change Order to initiate its review and approval by other Project participants. Up to this point, no other Project participant has been involved in the Change Order processing.
Submit the Change Order by selecting the [Submit] button. A Confirmation window will appear to confirm this action. Select **Yes** to continue or **No** to return.

The Change Order workflow is updated and processes any Alerts that are defined for this step.

The system is configured to send Alerts to the Owner, Contractor and Project Monitor. An Alert is sent for each logon associated with each project role.
T. Closing a Project

Closing a project will allow it to be placed in an “Inactive” status, and by limiting searches to “Active” projects, minimize the number of projects returned in searches. It is also beneficial to close projects while all information and people involved are available and current.

1. Construction Closeout

Project closeout begins with the construction contract. Once work is completed and the contract documentation is being finalized, a contractor evaluation is required. That is completed on the ‘Construction Contract’ ‘Evaluation’ tab. Please refer to the Evaluations section for additional information.

Review and update HUB data on the ‘HUB Participation’ tab. Change HUB status to “Finalization,” check the HUB Data is FINAL box and .

Remember that current HUB certification is checked and reported as of the data finalization so you will want to review data carefully before finalizing. A beneficial occupancy date and Final Acceptance Date must be entered before HUB data can be finalized.
### InterscopePlus User Manual

#### Table

<table>
<thead>
<tr>
<th>Stakeholder Name</th>
<th>Planned</th>
<th>Actual</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DESIGN REVIEW</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advanced Planning submitted to SCO</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Advanced Planning approved by SCO</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Schematic Design Submitted to SCO (First Submission)</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Schematic Design Approved by SCO (Final Approval)</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Design Development Approved by SCO (Final Approval)</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Construction Documents Submitted to SCO (First Submission)</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Construction Documents Approved by SCO (Final Approval)</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Final Documents Approved by SCO (Final Approval)</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td><strong>SCHEDULE AND CONTRACTS</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Approved to Bid</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Subcontracts for Bid</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Award Letter</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Contracts approved by Owner</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Contracts approved by AECO</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td><strong>CONSTRUCTION</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pre-Construction Conference</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Construction Start (notice to Proceed)</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Estimated Completion (Contract Completion)</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Notice to Proceed</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Notice to Proceed (Final)</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Notice to Proceed (Final)</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td><strong>CLOSEOUT</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Final Report Submitted to SCO</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Final Report Approved by SCO</td>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>Final Approval - Last step of Closeout Process</td>
<td>/</td>
<td>/</td>
</tr>
</tbody>
</table>

*Note: Highlighted row indicates a milestone required for PAY closeout.*
Once construction goes from “Under Construction” to “Beneficial Occupancy”, “Punchlist”, “Accepted” or “Closeout” status will appear on the Construction Closeout tab to “Start Construction Closeout”.

Go to the ‘Package Detail’ tab, change the Contract Status to one of the above status and .

NOTE: THE AWARD TYPE MUST BE SET AND WORK BE 100% COMPLETE UNDER MONTHLY PROGRESS.

Click on the “Go to Construction Closeout Details” tab.
InterscopePlus User Manual

[Image of InterscopePlus User Manual page]

[Rev. 8 June 2017]
Here you will see a workflow and five (5) tabs for document upload.

The workflow consists of and update, submittal and approval. The update and submittal are completed by the Designer and the approval by State Construction Office.

The Document tabs consist of the following:

1. Inspection
   a. Designer’s Verification of Punchlist Completion (if applicable)
   b. Final Inspection for Owner Occupancy
   c. Partial Utilization for Beneficial Occupancy (if applicable)

2. Claim Verification
   a. Refer to Section 506-Construction Claims in the State Construction Manual
   b. Answer a yes or no question regarding claims

3. Construction Closeout
   a. Final Pay Application
   b. Consent of Surety of Final Payment
   c. Contractor’s Affidavit of Release of Liens
   d. Contractor’s Affidavit of Payment of Debts and Claims
   e. Appendix E-MBE Documentation for Contract Payments

4. Designer Certificate
   a. Answer a yes or No question regarding Flood Plain Permit
   b. Certificate of Compliance
   c. Certificate of Completion
   d. Flood Plain Certificate of Compliance
   e. Floor Plain Elevation Certificate

5. Record of Drawings
   a. Instructions
   b. Disk Label
   c. Transmission
d. Enter dates drawings were sent

Once all documents have been uploaded and submitted by the designer, alerts will be sent to the Owner and the State Construction Office.

2. Package Completion

Once the workflow for the closeout is completed, the Package Status automatically changes to “Complete.”

3. Design Contract

Select the ‘Design’> ‘Evaluation’ tab, and complete designer evaluation.
Select the ‘Design’>‘Detail’ tab, change Contract Status to “Complete,” and...

Note: All packages must be complete or closed out for Design status to be changed to “Complete.”

4. **Contract Closeout**
Select the ‘Project’>‘Closeout Project’ tab. If the Steps 1 and 2 above were completed correctly, all the check boxes for “1 Contracts” should be checked.

The check boxes report completed activities and cannot be manually checked. If they are not checked, something was not completed in Steps 1, 2 or 3 above.
For “2 Milestones” check the box. Milestones include various key dates such as date of award and notice to proceed that are entered throughout the system during the life of a project. The Milestones tab summarizes key information. After completing the above, in the Financial Closeout section is a summary of assigned funds, committed funds and any available funds. To close out the project, the Available to Commit must be $0.

Certify Milestones and click “Close out Design/Construction”
There are 2 options. The first option is to select the Release Uncommitted Funds and let the system “Un-assign” the funds, releasing them back to the Program. This is recommended if there is only one fund source assigned to the project.

But, if there are multiple fund sources, navigate to the ‘Program’>’Assign Funds to Projects’ tab and change the assignment amount to equal the committed amount, then

This example illustrates multiple funding sources.

Return to the ‘Project’>’Closeout Project’ tab and the Available to Commit should equal $0.

Select Close out Project Financials. After executing this, the project is closed.
b) **Non-Code-Item Financial Closeout**

This type of project will not have a financial close out as shown below.
Closing a Program

Closing a Program is similar to closing Projects. To close a program, all projects must be closed, there can be no pending transfers, and there cannot be any unassigned funds. Funds cannot be assigned to closed projects, so any funds remaining in the program must be transferred to other Programs or the allocation from the Authorization must be reduced. Community Colleges and Universities should utilize the Funds Transfer function to request movement of funds or increase/decrease in authority. Permission to close programs will be established at the same levels as they were created. For the universities and community colleges programs will be closed by UNC GA or NCCCS System Office.

Once the Available to Assign funds is $0, click the **Close Program**.
VI. Advanced Functions

A. Funds Change Request

Funds change requests allow moving funds from an Authorization/Program to another Authorization/Program. It begins with entering a request, and continues with a sequential multi-step approval process.

A separate request must be created for each source of funds to be transferred.

The Program that the funds will be transferred from must have unassigned funds equal to or greater than the amount to be transferred within the source of funds to be transferred, i.e. the program must have $15,000 unassigned Non-General Fund (NGF) funds in order to be able to transfer $15,000 NGF. Excess funds in projects may be unassigned to increase the amount of unassigned funds available within a program.

At the top of your home page, select Funds Change Request>Funds Change Request to bring up the Funds Transfer Search Screen.

On the search screen, you can search for a previous request that has been made to check the status or create a new request. A new request may be either a transfer of existing funds from one program to another or an increase/decrease in authority. Increase/decrease in authority applies generally to Non-General Fund or Non-State Debt funding sources where the agency/institution is providing the funds, or releasing unneeded funds. Both follow a similar approval process.

1. Funds Transfer

Select the New Funds Transfer button. Search for the Program that you want to transfer the funds from and select the desired program. Enter the amount you wish to transfer. If there are multiple fund sources in the program, be sure to select the desired fund
source. Then, search for and select the Program to which you will transfer the funds. Enter appropriate remarks as to why you are transferring the funds. Then

This brings up the summary of the request, above. Select and you will see the workflow with the current status as shown on page 74 following submission. This also creates a “Pending Change” for the Authorization and Program financials shown below.

Select to send the request forward for approval.
Normally, the requester will not be approving the request for the Agency/Institution, but an email will be sent to the Approver, notifying him/her that there is a request for his/her action.

The person who is the next level up in the approval process will open the transaction and make a decision to accept or reject the request, by selecting the appropriate button under Workflow. They may make comments in the space provided at the bottom of the workflow, and an explanation in the comments is mandatory if they reject the request.

If that person disapproves the request, the original requester is notified and the process is complete. If that person approves the request, the system notifies the next higher level approver.

The 3rd level person must log in and navigate to the pending request.
They have the option of approving or disapproving the request using the "Approve" button, and making comments. If they disapprove, the requester and Agency approver are notified and the process is complete. If they approve, the request goes forward to the next level.

The status for the request remains in “Pending” until disapproved, or until the top level of the approval process approves it.

Once it receives final approval, the funds records will be updated and there will no longer be funds in a pending status. While funds are in a pending status, they may not be assigned, committed, or otherwise affected.

2. Increase/Decrease

To request an increase or decrease in funds, select the New Increase/Decrease button.
NOTE: You may only increase or decrease existing authority.

Search for and select the authorization you wish to increase. Enter amount and remarks, then continue.

This brings up the summary of the request. Select and you will see the workflow with the current status. Select to send the request forward for approval.

The workflow continues the same as a funds transfer request until it is approved or rejected.

B. Primavera (P6) Linking to Interscope

Primavera schedules are required for Standard Projects over $500K and are optional for smaller projects. Projects <$500K that are funded by R&R State Debt may be required to have schedules if OSBM or the State Treasurer require cash flow forecasting.

The P6 schedule is a planning tool for managing the project schedule and forecasting when milestones will occur. In general, milestone dates from P6 will be uploaded into Interscope as “Planned” dates and “Actual” dates will be entered in Interscope and automatically be downloaded into P6.
A schedule must exist in P6 to be able to link it to Interscope. It is recommended that the Project ID in P6 be the same as the Project ID in Interscope for ease of linking.

1. **Establishing the Link**
   
   Select the Project>P6 Link tab, select the box that says “Link Project Milestones to P6 Schedule,” and select the project from the dropdown project list.

2. **Select the Auto-Map Milestones** to have the program match as many milestones as possible without user intervention.

   Then . . . **Mapping individual Milestones.**

   As with other data fields in Interscope, milestone dates are related to the various parts of the project i.e. the designer contract milestone date is found in the design contract section, the construction contract milestone date is found in the construction contract section, etc. There are Milestone tabs at the project level, design contract level, package level and construction contract level. Where there are multiple contracts, ensure that the milestone is linked to the proper contract i.e. the commissioning authority contract milestone must be linked to the design contract for the commissioning authority, and the pre-con contract milestone to the pre-con contract.

   Select the Project>Milestones tab
In this case, the Designer Advertisement milestone did not map. Select ‘change’ for that activity and pick the activity from the dropdown list, then:

It is now linked and shows the planned advertisement date.

The linking process should be continued until all applicable milestones are linked. Not all Interscope milestones are in the P6 schedule. Not all P6 milestones apply to every project, as not every project has commissioning, or utilizes CM delivery. The milestones highlighted in gray should be in all P6 schedules. The required milestones must be linked and cannot be unlinked.
As the project progresses, actual dates are entered in Interscope, either by SCO for full oversight projects, or by agency/institution for other projects. Those actual dates are then downloaded into the P6 linked activity.

VII. Reporting

From the Home screen, select Reports> Global and Institutional Reports.

This will bring up a new screen with two tabs – Global Reports and Institutional Reports. In general, Global reports are available to owners (state employees) and contain information that would be of interest to users across all departments and agencies. Institutional Reports are available to owners but the data that can be retrieved with the report is limited to their respective agency/institution.

Select the desired report and it will appear in a new tab on your browser using the default criteria. The report may be filtered by selecting parameters from the sidebar. After selecting any parameters, click on “View Report” to see the new report. The selection parameters are shown in the report heading.

NOTE: You must disable pop-up blockers for this sight in order to see the reports.
The report may be exported to a PDF document, Excel, a word (.rtf) document, an HTML document, or to an image (.tiff).

If you want to search for a particular word or phrase, select binoculars at the bottom of the sidebar and it will bring up the search information.
VIII. Problem Reporting/ User Feedback/Help

A. Problem Reporting

The system has a tool for reporting problems that can be found at the bottom of each screen.
When a problem is encountered, click the button and the system will automatically capture a screen shot. Enter the requested information and .

**B. Contact**

The system administrator may be contacted by clicking on the “CONTACT ADMINISTRATOR” link on the logon page.
IX. Evaluations

This addendum to the User Manual covers the entry, update and submission of Designer and Contractor evaluations as required under the guidelines and policies established by the State Building Commission outlined in Subchapters 30E and 30F of the North Carolina Administrative Code. Relevant sections of this Code are listed below:

- Contractor Evaluations: [http://reports.oah.state.nc.us/searchRules.asp?title=&chapter=&searchCriteria=30F&returnType=Rule](http://reports.oah.state.nc.us/searchRules.asp?title=&chapter=&searchCriteria=30F&returnType=Rule)

Evaluations Overview

InterscopePlus automatically creates an evaluation record whenever a design and construction contract is created. However, designer evaluations are not created for In-house design contracts.

A. Evaluation Status

The system automatically maintains the active status of each evaluation on a daily basis.

For designer evaluations, the Package Final Approval date is used to determine the Due Date. Evaluations are “Due” within 60 days of the Final Approval date. (Note: On the Evaluation Search page, the Final Approval date has been labelled the “Project Completion” date).

For contractor evaluations, the Package Final Acceptance date is used to determine the Due Date. Evaluations are “Due” within 60 days of the Final Acceptance date.

These dates can be found on the Package “Milestones” tab.

Interscope allows a grace period of 60 days past the Due Date at which time, the system marks the evaluation as “Past Due”.

Evaluations remain in a “Pending” status until Final Approval or Final Acceptance dates entered at which time the due date is calculated.

B. Evaluation Rating

Evaluations are automatically assigned one of the following ratings when the system processes the raw score from the uploaded evaluation form:

- UNRATED
- UNACCEPTABLE
- POOR
- ACCEPTABLE
- EXCELLENT

The rating determination details can be found in the detail evaluation forms that are generated and downloaded from the system:
### C. Accessing Evaluations

Evaluation information can be found in InterscopePlus in the Home page or any level of the Project data structure: Project, Design Contract, Package or Construction Contract.

1. **Home Page – “Active Evaluations” tab:**

   A special "clipboard" tab has been added to the Home page to aid in the identification of “active” evaluations. An **“active” evaluation is one that has not yet been completed having a status of “Pending”, “Due” or “Overdue”**.

   **Note** – **“Completed” evaluations will not be listed under the “Active Evaluations” tab.**

   It is intended that this tab be used as a working queue of evaluations that need to be completed for owner projects. Therefore, when an evaluation is marked “Complete”, it will no longer appear under this tab. The Evaluation Search page can be used to locate completed evaluations.
2. **Project Detail – “Evaluations” tab**

All designer and contractor evaluations for all contracts under the project are listed under this tab.

3. **Design Contract Detail – “Evaluations” tab**

The designer evaluation and all evaluations for contractors under all packages under this design contract are listed under this tab.

The designer evaluation can be added from this tab.

4. **Package Detail – “Evaluations” tab**

The designer evaluation and all evaluations for contractors for this package under this design contract are listed under this tab.

The designer evaluation can be added from this tab.

5. **Construction Contract Detail – “Evaluations” tab**

The evaluation for the contractor on this contract is listed under this tab.
The contractor evaluation can be added from this tab.

6. Project Design and Construction Closeout

The evaluation search page can be used to perform more complex queries of evaluation information.
D. Maintaining Evaluations

To update evaluations, locate the evaluations using one of the methods described in “Accessing Evaluations”.

Click on the Evaluation# to open the evaluation for review and/or update:

Follow the instructions listed at the top of the Evaluation detail page. You may also visit the relevant Administrative Code Subchapters for detailed instructions and guidelines for completing your evaluation. These links are listed in the Instructions section.
E. Generating the Evaluation Form

The first step is to generate a downloadable evaluation form to be completed and uploaded.

Clicking on the “Generate and Download...” button will cause Interscope to create a pre-filled evaluation Excel file specific to this firm and project.

The generated evaluation Excel file will appear at the bottom of your screen depending upon the browser that is used:

Google Chrome download:

Internet Explorer download:

Open the file for editing.

F. Completing the Evaluation Form

1. Designer Evaluations
The evaluation form is an Excel spreadsheet containing the detail sections to be completed for the evaluation. You will notice that Interscope has pre-filled the header portion of the spreadsheet with project and firm information. This area of the spreadsheet is locked and cannot be changed. Upon upload, Interscope checks the SCO ID # on the form to verify that the correct evaluation form is being uploaded.

The only cells open for update are highlighted as shown below. All other cells are locked and cannot be changed.

As each raw score is entered, the spreadsheet calculates the TOTAL SCORE for the evaluation and assigns the final RATING according to the scoring details described in the Overview section of this guide.

For designer evaluations, a raw score from 0 – 5 can be entered. Sections that are not applicable can be skipped and will not influence the TOTAL SCORE.
### 2. Contractor Evaluations

Contractor evaluations are handled in the same manner. The SCO ID # is recorded on the generated form.

The only cells open for update are highlighted as shown below. All other cells are locked and cannot be changed.

As each raw score is entered, the spreadsheet calculates the TOTAL SCORE for the evaluation and assigns the final RATING according to the scoring details described in the Overview section of this guide. Comments for each section may be added as appropriate in the section at the right.

For contractor evaluations, a raw score from 0 – 3 can be entered. All sections must be completed as they influence the TOTAL SCORE.

<table>
<thead>
<tr>
<th>Question</th>
<th>Evaluation Category</th>
<th>Relative Importance</th>
<th>RATING</th>
<th>SCORE</th>
<th>Administrative Code Requirement</th>
<th>Construction Contract Reference</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Did the contractor submit the documentation required by the contract in order to award and execute the construction contract for the project in a timely and complete manner in accordance with G.S. 143-129.6?</td>
<td>Did the contractor submit the documentation required by the contract?</td>
<td>3</td>
<td>3</td>
<td>15</td>
<td>&quot;Documents required for award, including Minority Business Enterprise (MBE) data, bonds, insurance documentation, and the executed contract documents.&quot;</td>
<td>Instructions to Bidders, Section General Statutes 143-129.6</td>
<td>My Comments here</td>
</tr>
<tr>
<td>Did the contractor manage the submittal process for all submittals required by the project specifications in a timely and effective manner?</td>
<td>Did the contractor manage the submittal process?</td>
<td>3</td>
<td>3</td>
<td>15</td>
<td>&quot;Shop drawing processing.&quot;</td>
<td>Instructions to Bidders, Section General Conditions, Articles 3, 13a, 14</td>
<td></td>
</tr>
</tbody>
</table>
3. Uploading the Evaluation Form

Review, save and exit Excel to complete the data entry of the evaluation.

Return to Interscope, and click on the button to begin the upload process.

The file uploader pop-up window will then appear.

Click on the “Choose File” button to browse, find and select your completed evaluation spreadsheet file.

Click on the “Upload File(s)” button to begin the uploading process.
Interscope will then upload, validate and process the evaluation information, verifying the correct SCO ID # and recording the Total Score and Rating from the form.

In addition, a PDF version of the Excel file will be created and stored with the evaluation and available for printing and download from the “Print” option under the “Action” menu.

Once the form is successfully processed, a message is displayed detailing the results of the upload.
The Summary and Report sections of the evaluation will display the Rating and Raw Score from the uploaded evaluation.

4. Finalizing the Evaluation

To complete the evaluation, select the Report Type (Interim or Final) from the drop down and check the “Mark Report Complete?” box. Then save these updates from the Action menu.

The evaluation is now complete allowing Design and Construction Closeout to proceed.

5. Alert Notifications

Designer and Contractor users that are registered in Interscope are notified via the Interscope alerting system that their evaluation has been completed.

They receive an email with an alert which contains a link to the evaluation. Clicking on this link will bring them to the Logon screen and after logon, to the evaluation record for their review and comments.
Firms can record their responses to the evaluation in the Firm Comments section of the evaluation.

---

G. Project Design and Construction Closeout

The completed evaluation now appears with a check in the “Ratings Present?” section of the Project – Closeout Project tab.
All evaluations for a given project must be completed to allow the project to proceed to Design and Construction Closeout.

H. Certificate of Merit Recommendations

If a firm receives an Excellent rating, recommendation for a Certificate of Merit award can be made by checking the “Recommend Firm for Certificate of Merit Award?” checkbox.

Saving this change will initiate an alert via email to the State Construction Office for Merit Award consideration.
X. Creating Owner Contracts on Full Oversight projects

1. Step 1 – Select the Project and access the “Contracts” tab:
2. Step 2 – Click on the “Add Owner Contract” button to add an owner contract:

3. Step 3 – Select the Designer for the contract:
4. Step 4 – Once the designer is selected, the New screen will be displayed. Complete data entry selecting the desired contract type and entering data for the remaining fields.

5. Step 5 – Use Action->Save to create the contract. Notice that only a subset of the tabs are displayed for owner contracts.

NOTE: For Open End Design Contracts, the “Packages” tab is also displayed to allow users to add construction contracts under the associated package.
XI. Primavera (P6) Linking to Interscope

A. Overview

Oracle’s Primavera P6 Enterprise Project Portfolio Management is a powerful, robust and easy-to-use solution for prioritizing, planning, managing and evaluating projects, programs and portfolios. It is a cloud based “Software as a Service” (SaaS) solution providing a 100% web-based solution for managing projects of any size, adapts to varying levels of complexity across projects and intelligently scales to meet the needs of all roles, functions, or skill levels in an organization.1

This addendum to the User Manual covers the linking, update and synchronization of schedule milestones between the State Construction Office Interscope System and the University of North Carolina General Administration’s cloud-based Primavera P6 system. Specifically, it addresses the following features:

1. Linking an unlinking Interscope projects and Primavera schedules
2. Mapping milestones between the systems
3. Updating and synchronizing Primavera milestone planned dates
4. Updating and synchronizing Interscope milestone actual dates
5. The capture of Primavera cost information
6. Background batch updating

The intended user base for these features are the project managers responsible for project schedules who are involved with Interscope capital improvement projects.

6. Step 6 - The contract will now appear under the Project’s “Contracts” tab.
B. Getting Started

Interscope Version 2 now includes features for linking to schedules that exist in a Primavera P6 Project scheduling system. The integration works in the following manner:

- Milestone Planned dates flow from Primavera to Interscope
- Milestone Actual dates flow from Interscope to Primavera
- Interscope “pushes” actual dates to Primavera schedule milestone activities as they occur
- Interscope “pulls” Primavera milestone activity planned dates based upon user actions. (Additionally, an Interscope batch job runs periodically to keep Interscope projects and Primavera schedules synchronized with up-to-date information.)

Prerequisites for establishing the linkage between an Interscope project and its associated Primavera schedule include the following:

1 – The Primavera P6 schedule must reside in the Primavera P6 Enterprise system hosted by the University of North Carolina General Administration. This is the only Primavera P6 system that Interscope currently supports.

(To obtain information about licensing and user accounts for this system, please contact Lindsay Noth at lmnoth@northcarolina.edu.)

2 – The Primavera P6 project schedule must be created using the custom UNC GA templates. These reside in the “Templates” section in UNC GA Primavera P6 system:
The templates contain the custom columns that enable the integration of the two systems:

<table>
<thead>
<tr>
<th>At Completion</th>
<th>Total Cost</th>
<th>Latest iPlus Update</th>
<th>UNC Milestones</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**UNC Milestone**

- the common milestone code for the P6 activity and Interscope date which is used to link and update planned and actual dates between the systems.
- date of the last update/synchronization from Interscope. This date is updated for each activity when an update is triggered from Interscope.

3 – The P6 schedule must be “Active”. Interscope will ignore all schedules that have been closed. These will not be visible in the Interscope P6 project listing displayed for linking.
C. The Integration Process

Primavera schedules are required for Standard Projects over $500K and are optional for smaller projects. Projects <$500K that are funded by R&R State Debt may be required to have schedules if OSBM or the State Treasurer require cash flow forecasting.

The P6 schedule is a planning tool for managing the project schedule and forecasting when milestones will occur. In general, milestone dates from P6 will be uploaded into Interscope as “Planned” dates and “Actual” dates will be entered in Interscope and automatically be downloaded into P6.

A schedule must exist in P6 to be able to link it to Interscope. It is recommended that the Project ID in P6 be the same as the Project ID in Interscope for ease of linking.

1. Select the Project>P6 Link tab, select the box that says “Link Project Milestones to P6 Schedule,” and select the project from the dropdown project list.

Select the Auto-Map Milestones to have the program match as many milestones as possible without user intervention.

Then . Mapping individual Milestones.
As with other data fields in Interscope, milestone dates are related to the various parts of the project i.e. the designer contract milestone date is found in the design contract section, the construction contract milestone date is found in the construction contract section, etc. There are Milestone tabs at the project level, design contract level, package level and construction contract level. Where there are multiple contracts, ensure that the milestone is linked to the proper contract i.e. the commissioning authority contract milestone must be linked to the design contract for the commissioning authority, and the pre-con contract milestone to the pre-con contract.

This is a project after linking to P6
As the project progresses, actual dates are entered in Interscope, either by SCO for full oversight projects, or by agency/institution for other projects. Those actual dates are then downloaded into the P6 linked activity.

XII. In-House Designers and Project Coordinators

A. Creating In-House designer profiles

Access the Designer search page from the Companies option on the Main Menu.

Click on the Add Designer button.

![Add Designer button](image)

Complete the New Designer input form. Required fields are flagged with a red asterisk.

For Name, Email, Address and Contact, enter information for the agency employee who will be performing the work.

For In-House Designer profiles, prefix the name with “In-House Design by”, before the agency name.

Examples:

<table>
<thead>
<tr>
<th>ID</th>
<th>DESIGNER</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In-House Design by Appalachian State University</td>
</tr>
<tr>
<td>2</td>
<td>In-House Design by DRRS - Forest Resources (INACTIVE)</td>
</tr>
<tr>
<td>3</td>
<td>In-House Design by DRRS - Museum of Natural Sciences</td>
</tr>
<tr>
<td>4</td>
<td>In-House Design by Department of Administration</td>
</tr>
<tr>
<td>5</td>
<td>In-House Design by Department of Administration - Facility</td>
</tr>
<tr>
<td>6</td>
<td>In-House Design by Department of Agriculture &amp; Consumer Services</td>
</tr>
<tr>
<td>7</td>
<td>In-House Design by Department of Boards &amp; Commissions</td>
</tr>
<tr>
<td>8</td>
<td>In-House Design by Department of Commerce</td>
</tr>
<tr>
<td>9</td>
<td>In-House Design by Department of E &amp; NF</td>
</tr>
<tr>
<td>10</td>
<td>In-House Design by Department of EAW - Marine Fisheries</td>
</tr>
</tbody>
</table>
For In-House Project Coordinator profiles, prefix the name with “In-House Project Coordination by” before the agency name.

Examples:

<table>
<thead>
<tr>
<th>ID</th>
<th>DESIGNER</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In-House Project Coordination by Montgomery CC (TEST)</td>
</tr>
<tr>
<td>2</td>
<td>In-House Project Coordination by Randolph CC</td>
</tr>
</tbody>
</table>

Select the Save option on the Action menu to complete the new designer profile record.

B. Assigning Profiles to Agencies

Click on the “In-House Agencies” tab

Click on the “Add Agency to InHouse Designer” button to display a pick list of Agencies.
Select the desired agency for this in-house designer profile assignment.

To create a project coordination profile, check the “Limited to Project Coordination Only – Not a licensed architect” flag.

To create a licensed in-house architect profile, leave this checkbox unchecke.

Click on the “Add Agency” to assign the in-house profile to the agency.

A message will be displayed indicating successful assignment of the profile to the agency.
The assignment cannot be updated after it is created. It must be removed using the “In-House Agencies” tab and re-added.

Click “Done” to return to the “In-House Agencies” tab.

Confirm that the correct Role has been assigned for the agency for this profile.

C. Creating Contracts using in-house designer profiles

Design contracts can be created using In-House designer profiles under 2 scenarios:

1. Design contracts where a licensed architect is required by General Statute 133.1.1 Subsection (a) and there is a licensed architect in-house for the agency.
Design contracts where a licensed architect is not required by General Statute 133.1.1 Subsections (c) and (d) and there is a project coordinator in-house for the agency.

Access the **Contracts** tab on the **Project Detail** page and click on the “**Add Design Contract**” button.

Search for and select the desired in-house designer profile.

Since the in-house designer profile has been associated with the owning agency, Interscope will create an in-house design contract and set the Contract Status and Type.
D. Special considerations for In-House Project Coordinator profiles

1. A. Verification of compliance with North Carolina General Statute 133.1.1

Design contracts created under an In-House Project Coordinator profile must be verified with compliance to NC General Statute 133.1.1.

Verification of compliance is indicated using the checkbox in the N.C. General Statute 133.1.1 Compliance section of the design contract form.

A validation message is displayed if this checkbox is not completed when the contract is saved.
The user logon and date of verification of compliance is then recorded at the time the contract is created.
E. Construction Contract limits

In compliance with G.S. 133.1.1 subsections (a) and (d), construction contracts created under inhouse project coordination contracts will be limited:

1. Under $300,000 – where the project has a total projected cost of less than $300,000 for the repair of public buildings where such repair does not include major structural change in framing or foundation support systems.

2. Under $100,000 – where the project has a total projected cost of less than $100,000 and does not affect life safety systems.

3. Under $135,000 – where the project has a total projected cost of less than $135,000 for the repair of public buildings where such repair includes major structural change in framing or foundation support systems.

F. Permissions
To enable the use of in-house designer profiles, a Non-SCO User or Group must have the following permission enabled:

- **inHouseContracts**

### XIII. Data Importing for Connect NC Bond Cash flows

#### Preparing the Connect NC Bond Cash flow import file

Step 1 – Download the Connect NC Bond Cash flow import spreadsheet and complete your data entry into the spreadsheet. The spreadsheet template is found under “**Forms**” on the Main Menu bar:
Before entering data, familiarize yourself with the Instructions and Example tabs to avoid any unnecessary data import errors.

1. Complete the following fields:
   - Department
   - Agency
   - Fiscal Year
   - Frequency (Monthly, Quarterly)
   - Period (Month or Quarter)
   - Preparer’s Name
   - Preparer’s Email address

2. If your Interscope project is linked with a Primavera P6 schedule:
   - Enter the P6 Project ID in the corresponding field.
   - Leave the Interscope Project ID and Agency Project Code fields blank. These will not be used to process your input data.
   - Note that if you select Linked to P6 = YES during the Data Import, ALL projects in the spreadsheet MUST BE LINKED to P6.
   - Go to Step 4

3. If your Interscope project is not linked with a Primavera P6 schedule:
   - Enter both the Interscope Project ID and Agency Project Code in the corresponding fields.
   - Leave the P6 Project ID blank. This will not be used to process your input data.
   - Go to Step 4

4. For each project reported:
   - Enter 1 row of data for each of the 3 Cost Types:
     - Baseline Total
     - Budgeted Total
     - Actual Total
   - Enter “2016 Bond Funds” in the Bond Fund Source column
   - Enter Column data for 8 fiscal years from Q1 FY2016 through Q4 FY2024
   - Refer to the Example tab as a reference
   - For each row of data, enter an amount for each fiscal quarter for each fiscal year.
   - Enter 0 if no cost information is applicable for a particular period.

5. To report additional projects:
   - Select a completed row in the worksheet and insert a new row.
   - The new row should contain the correct information and validations for each cell.
   - Remember to enter 3 rows (one for each Cost Type) for each project reported.

6. Save the spreadsheet and upload it into Interscope using the “Data Import” feature or send it via email to: interscope@doa.nc.gov
Importing Connect NC Cash Flow projections

Step 1 – Once the cash flow spreadsheet is complete, select the “Import Data” option under “Data” on the Main Menu bar:

Step 2 – Select options for the following:
- Projects Linked to P6
- Department
- Agency
Step 3 – Click “Browse to select the import file”:

The System will display the following pop-up during the importing process.
Step 4 – If the import is successful, a message will display indicating the number of records processed. If unsuccessful, an error report will be generated and displayed listing the errors found.
Once a successful import has been accomplished, the cash flow projections are ready for reporting. To run the Connect NC Bond report, select “Custom Reports” under the “Report” menu on the Main Menu bar.

Complete the report run criteria and press the “Run Report” button. Your report will display in a new tab.
Managing Data Import files

To view or replace cash flow information that has been uploaded for any given period, select “Data Import Search” under “Data” on the Main Menu bar:

To remove a file, check “Delete?” and then click on “Save Changes”
To download any imported cash flow file, select “Upload Search” under “Data” on the Main Menu bar:

Click on the File Name to download the file.